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About CELA Connect  

This CELA Connect software allows you to download 
titles from your CELA Library Direct to Player bookshelf 
to your Envoy Connect player or computer. 

To use CELA Connect you have to be a registered 
member of the CELA Library and have a Username and 
Password. 

If you are not a member, contact the CELA Library at 1-
855-655-2273, or by email: help@celalibrary.ca 

CELA Connect is designed for Microsoft Windows 10. 

For CELA Connect to work, the computer must be 
connected to the internet. 

How to Install 

There are two methods of installing the CELA Connect 
software: 

• Directly from the Envoy Connect player 
• Downloading from CELA Library 

Installing from the Player 

The CELA Connect software can be found in the 
SYSTEM folder on the Envoy Connect player.  The 
installation file is called ‘CELAConnectInstaller.exe.’ 

mailto:help@celalibrary.ca
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To install the software, ensure the player is switched off, 
then plug it into the computer using the supplied USB 
data cable.  The player will emit a chime to confirm the 
connection. 

Note that Windows File Explorer may open automatically 
when you connect the player. 

The player is called CONNECT in File Explorer.  Open 
this to view the SYSTEM folder on the player. 

Within the SYSTEM folder, there is a folder called ‘CELA 
Connect’.  The CELA Connect software is in this folder. 

Select the ‘CELAConnectInstaller.exe’ file to begin 
installation. 

During installation, you may be presented with a 
‘Microsoft Windows Security Warning’ asking if you want 
to install the software.  Select the ‘Install’ button.  

An ‘CELA Connect’ shortcut (icon) will be placed on your 
desktop when the installation is finished.   

Installing from the Website 
The CELA Connect software can be downloaded from 
https://celalibrary.ca/CELA-Connect 

Once the CELA Connect software has finished 
downloading to the Downloads folder on your computer, 
select the ‘CELAConnectInstaller.exe’ file to begin 
installation. 

https://celalibrary.ca/CELA-Connect
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During installation, you may be presented with a 
‘Microsoft Windows Security Warning’ asking if you want 
to install the software.  Select the ‘Install’ button.  

A ‘CELA Connect’ shortcut (icon) will be placed on your 
desktop when the installation is finished. 

Before you Begin… 

There are two main modes of operation for the CELA 
Connect software: 

• Envoy Connect mode (Download to an Envoy 
Connect player) 

• Local Computer mode (Download to the Computer) 

The Envoy Connect mode is the default mode. 

The alternate modes are described further in the ‘CELA 
Connect Options’ section below. 

Note that when you run CELA Connect, the title bar 
displays the current CELA Connect mode (Envoy 
Connect or Local Computer). 

How to Use CELA Connect - Envoy Connect Manual 
Mode 

Envoy Connect Manual mode is the default mode.  It 
allows you to choose titles to remove from the player 
and choose new titles to download from your Library 
bookshelf onto the player. 
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Plug In the Player 

Ensure your Envoy Connect player is switched off, then 
connect your player to the computer using the supplied 
USB data cable.  The player will emit a chime to confirm 
the connection. 

Note that if CELA Connect is running before plugging in 
the player, it will prompt you to plug it in. 

Open CELA Connect 

To run CELA Connect, use the CELA Connect icon on 
your computer desktop. 

When you first run CELA Connect a ‘Getting Started’ 
guide will appear that provides a brief overview of the 
CELA Connect software. 

You can choose not to display the Getting Started guide 
next time you run CELA Connect by deselecting the 
‘Show next time on Startup’ checkbox.  You can also 
access Getting Started and this User Guide at any time 
from the Help menu. 

Select the ‘Close’ button to proceed. 

A message will confirm that a player is plugged in. 

Select the ‘Continue’ button to proceed or the ‘Cancel’ 
button to return to the main screen. 
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To login to the Library from the main screen, select the 
'Connect to Library' button. 

Login 

If your player is registered with the Library, the player 
will be recognised by the system and login 
automatically. 

If your player is not registered, you will be prompted to 
enter your Library Username and Password. 

‘Tick’ the ‘Save Username/Password’ checkbox to avoid 
entering it each time.  If your login fails for any reason, 
the login screen reappears. 

Select the ‘OK’ button to proceed. 

CELA Connect will connect to the CELA online Library. 

Note that logging in may take a few minutes depending 
on the size of your Direct to Player bookshelf and the 
speed of your internet connection.  Do not unplug your 
player. 

If there is a message from the Library, a ‘popup’ window 
will appear during login.  Select the ‘Close’ button to 
retain the message or select the ‘Delete’ button if you do 
not wish to read it again. 

Connection Status 



Page 9 CELA Connect 3.0, October 2021 

When logging in to the Library and downloading, a 
status field always shows the progress.  This window 
also shows the Username of the logged in person and 
the player serial number. 

Select the ‘Cancel’ button if you want to stop the 
process at any time and return to the main screen. 

Note that if you cancel downloading, only those titles 
that have completed downloading will be playable on the 
player.  When you next run CELA Connect, you will 
need to reselect the titles from your bookshelf to resume 
downloading them. 

Select Titles to Remove 

Once CELA Connect has logged on, CELA Connect will 
display the ‘Select Titles to Remove’ window. 

This is the list of titles currently on your Envoy Connect 
player.  

Select one or more titles from the list to remove them 
from your player.  This will also remove them from your 
Direct to Player bookshelf. 

Removing titles will allow more titles to be added to your 
Direct to Player bookshelf to replace those that you 
remove. 

You can also use the ‘Select All’ or ‘Deselect All’ 
buttons. 
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Note that you do not need to remove any titles, however, 
eventually the memory on the player will become full 
preventing you from downloading more titles. 

Select the ‘Next’ button to proceed. 

Select Titles to Download 

CELA Connect will display the ‘Select Titles to 
Download’ window. 

This is the list of titles currently on your Direct to Player 
bookshelf that you can download. 

Select one or more titles from the list to download to 
your player. 

You can also use the ‘Select All’ or ‘Deselect All’ 
buttons. 

Note that if this list is empty, your new titles are being 
prepared in the background.  Populating your bookshelf 
may take up to24 hours.  Continue to the next step and 
check the list again later. 

Select the ‘Next’ button to proceed, or the ‘Back’ button 
to return to the previous screen. 

Confirm Content Update 

CELA Connect will ask you to confirm the selections you 
have made in the previous windows. 
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Select the ‘Next’ button to proceed with the content 
update (removing and downloading). 

If you wish to review or change your selections, select 
the ‘Back’ button.  

Note that if you use the ‘Back’ button you will need to 
reselect any titles you had previously selected. 

You can select the ‘Cancel’ button if you want to ignore 
all previous steps and return to the main screen. 

Note that downloading content onto your player may 
take some time depending on how many titles you have 
selected and the speed of your internet connection. 

Once the downloading of content commences, the 
Status field will keep you informed of progress. 

Do not disconnect the player or exit the program until 
CELA Connect confirms ‘Your content has been 
updated'. 

Update Completed 

The ‘Content Updated’ confirmation message will be 
displayed once the download of content has finished. 

It is now safe to disconnect the player.  Note that it is 
always good practice to use the Windows USB Eject 
feature when removing USB devices. 
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Select the ‘OK’ button to return to the main screen of 
CELA Connect.  Select the ‘Exit’ button to close the 
CELA Connect software. 

How to Use CELA Connect - Local Computer Mode 

The instructions for Local Computer mode are the same 
as Envoy Connect Manual mode, except that the 
content is downloaded to your local computer instead of 
to your Envoy Connect. 

How to Use CELA Connect - Envoy Connect 
Automatic Mode 

Important Note: Only use Automatic mode after you 
understand how it works as described below. 

Envoy Connect Automatic mode always removes all 
content from your Library bookshelf as well as your 
player.  It downloads all of the new titles from your 
bookshelf onto the player without user input or 
confirmation. 

Be sure you wish to always automatically remove all 
content from your player and bookshelf before selecting 
this mode. 

Login 

The instructions for logging on and monitoring progress 
are the same as Manual mode. 
Removing All Titles h2 
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Once you are logged on in Automatic mode, all content 
is immediately removed from the player and also from 
your Direct to Player bookshelf. 

Once all titles are removed, new titles will be added to 
your Direct to Player bookshelf in the background.  
Populating your bookshelf may take up to 24 hours. 

CELA Connect will ask you to wait for 24hours before 
continuing.  Select the ‘OK’ button to return to the main 
screen of CELA Connect while you wait. 

Note that if this is the first time you are connecting a new 
player, there are no titles on the player to remove.  
CELA Connect will immediately begin to download the 
current bookshelf. 

Downloading All New Titles 

After waiting for up to 24 hours, run CELA Connect with 
the player plugged in. 

Downloading will begin automatically and the Status 
field will keep you informed of progress. 

Do not select the ‘Cancel’ button, disconnect the player 
or exit the program until CELA Connect confirms ‘Your 
Content has been updated'.  Interrupting the download 
will result in the removal of titles that have only partially 
downloaded and CELA Connect cannot re-download 
them. 
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When the ‘Content Updated’ confirmation message 
appears, select the ‘OK’ button to return to the main 
screen of CELA Connect.  Select the ‘Exit’ button to 
close the CELA Connect software. 

It is now safe to disconnect the player.  Note that it is 
always good practice to use the Windows USB Eject 
feature when removing USB devices. 

Using Two Players 

In Automatic mode, a new list of titles is generated on 
the bookshelf every time a player is connected.  This 
allows a person to use two Envoy Connect players, each 
with a different list of titles. 

For example, a user can listen to one player while their 
second player is taken away to be updated by, say, a 
family member or friend. 

CELA Connect Content Folder 

When you select Local Computer mode, a new folder 
called ‘CELA Connect Content’ is placed on your 
computer desktop.  This is where all downloaded titles 
are saved in Local Computer mode. 

Note that depending on your computer settings, this 
folder may contain a file called ‘_Bookshelf.xml’.  Do not 
move or delete it.  Doing so may affect the content 
update process.  If you accidentally move or delete this 
file, please contact CELA for assistance. 
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Main CELA Connect Screen 

This window allows you to connect to the Library and 
start the content update process.  It also provides 
access to your ‘CELA Library’ website, desktop content 
folder, as well as the File and Help menus. 

Select the 'Connect to Library' button to connect to the 
CELA Library, view your Direct to Player bookshelf and 
update content on your player or computer. 

Select the ‘CELA Library’ button to access your Library 
account.  The website will open in a separate window.  
Using the CELA Library website, you can set user 
preferences as well as search and add titles to your 
bookshelf. 

Select the ‘Exit’ button if you are finished using the 
CELA Connect software. 

Note that the CELA Connect title bar displays the 
current mode (Envoy Connect or Local Computer). 

File Menu 
Options 
Device Type 

You can select two main devices to be used by CELA 
Connect. 

Envoy Connect Player 
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Select this option to download from your Direct to Player 
bookshelf onto your Envoy Connect player. 

This is the default option when you install CELA 
Connect. 

Local Computer 

Select this option to download from your Direct to Player 
bookshelf onto your computer. 

Player Loading Mode 

There are two loading modes when you choose to load 
to an Envoy Connect Player. 

Manual 

This option allows you to choose new titles to download 
from your Library bookshelf onto your player, and titles 
you would like to remove from the player. 

Automatic 

This option automatically updates the player without any 
user input or confirmation. 

It immediately removes all titles from the player and 
Direct to Player bookshelf, generates a new list of titles 
and downloads all new titles from your bookshelf onto 
the player. 
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Automatic mode allows use of two Envoy Connect 
players, each with a different list of titles. 

Use this mode with caution.  Any time you connect your 
player all content will be removed from both your player 
and your Direct to Player bookshelf.  CELA Connect 
cannot re-download titles once they are deleted. 

Show ‘Getting Started’ on Startup 

You can choose to display or not display the Getting 
Started guide each time you run CELA Connect by using 
the ‘Show Getting Started on Startup’ checkbox. 

Clear Saved Username and Password 

If you previously chose to save your username and 
password when logging in, you can select the ‘Clear 
Saved Username and Password’ button so that you are 
prompted to enter them again when you next run CELA 
Connect. 

This is useful if your CELA Connect is to be used by 
someone else to prevent them logging into your 
account. 

Use Default Content Location 

The ‘Use default location in Local Computer mode’ 
checkbox is selected by default.  This saves 
downloaded titles to the ‘CELA Connect Content’ folder 
on your computer desktop. 
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You can choose a different location by ‘unticking’ the 
checkbox and selecting ‘Browse’.  This opens a ‘Browse 
for Folder’ window where you can choose a different 
location or create a new folder by using the ‘Make New 
Folder’ button.  Select the ‘OK’ button to save your 
preferred location.  Use the 'Cancel’ button to return to 
the Options menu without saving your changes. 

The ‘Content Location’ field displays the file path. 

Note: when choosing a different folder location, be sure 
not to choose the CONNECT Drive.  This drive is the 
Envoy Connect player.  If you wish to download to the 
player, choose Envoy Connect Mode from the Options 
menu. 

Exit the Options Menu 

After you set your preferences, select the ‘OK’ button to 
save your changes and return to the main screen. 

Note that CELA Connect will remember the currently 
selected settings each time you run the software. 

Select the ‘Cancel’ button to return to the main screen 
without saving your changes. 

Open Content Location 

This opens the ‘CELA Connect Content’ folder from your 
desktop in Windows File Explorer. 
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Within this folder there is another folder called 
Downloads.  This is where all downloaded titles are 
saved if you use Local Computer mode. 

Note that this menu item is only visible if you are using 
Local Computer Mode. 

‘CELA Library’ Website 

This opens the CELA Library website in a separate 
window.  Here you can access your Library account to 
set user preferences as well as search and add titles to 
your bookshelf. 

Exit 

Select Exit to close CELA Connect. 

Help Menu 
Getting Started 

Opens the ‘Getting Started’ guide. 

You can choose if the Getting Started guide is displayed 
when you run CELA Connect by selecting or deselecting 
the ‘Show next time on Startup’ checkbox. 

Select the ‘Close’ button to return to the main screen. 

User Guide 

Opens the ‘User Guide’. 
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Select the ‘Close’ button to return to the main screen. 

About 

Information about CELA Connect, including the version 
number and CELA contact details. 

Select the ‘OK’ button to return to the main screen. 

New Versions of CELA Connect 

Each time you run CELA Connect, it checks if a newer 
version is available.  If a software update is available, it 
will automatically update. 

When a software update occurs, a progress status 
screen will appear momentarily.  You do not need to do 
anything.  When the software update is finished, CELA 
Connect will open as normal. 

If a software update has occurred, the ‘Getting Started’ 
guide will be displayed and describe ‘What’s New’ in the 
latest version of CELA Connect. 

Contact and Support 

We want your experience using CELA Connect to be the 
best possible.  If you have any questions or comments, 
please contact CELA on 1-855-655-7723 or email: 
help@celalibrary.ca 

End of document 

mailto:help@celalibrary.ca
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